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Read this First



1.1



Scope of this Guide This guide introduces the PARAGON User Interface. It explains the menus, forms, Tables and reports. If you are not yet familiar with the use of the PARAGON Modules, it is recommended that you first work through one or more of the discipline-specific 'getting started' guides and practise using the various DESIGN applications. You also need to be familiar with the main principles of managing Catalogues and Specifications in PDMS databases using the PARAGON and SPECON modules: the use of Design Templates provides an extension of those facilities.



1.1.1



Intended Audience This guide has been written for engineers familiar with PARAGON applications.



1.1.2



Assumptions It is assumed that you know: •



where to find PDMS on your computer system



•



you know how to use the Windows operating system installed on your site.



Contact your systems administrator if you need help in either of these areas.



1.2



How the Guide is Organised The guide is divided into chapters, as follows: Getting Started



describes how to switch between modules and details the generic items



Menus



describes the menu items



Forms



describes the various forms and what you can do within them



Reports



describes the main reports and how to use them



Tables



describes the various tables and how to use them



Exercises



provides worked examples of the main Category and Specifications functions
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2



Getting Started



2.1



Switching Modules To switch from PARAGON to another module: Select Paragon>Modules from the main menu bar to display a sub-menu listing all the other modules by their functions, as follows: •



Module Sub-menu Option



•



Monitor Session Manager



•



Design * Design Constructor



•



Spooler * Pipework spooling



•



Draft * Drawing Creator



•



Isodraft * Isometric Generator



•



Specon Specification Constructor



•



Propcon Properties Constructor



•



Lexicon Dictionary Constructor



•



Admin Project Administration



Note: Modules marked with * have Graphical User Interfaces (GUIs) and can be loaded from any saved binary files or the original macro files. The sub-menus available from these options allow you to select which files to use when loading the module. •



Select the required module and loading option, if appropriate, from the menu.



You will be asked whether or not you want to save any changes made since your last Save Work operation. Select Yes to update your current databases or No to reject all recent changes. You will then leave PARAGON and enter the selected module. For another way of exiting, see CE Button.
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2.2



Command Window



If you want to type in commands instead of using the menus and forms, select Display>Command Line to display the Command Window. Type your command input in the Command> text box at the bottom of the form and press Return to enter it. The scrollable list shows the commands entered and any resulting output. (Refer to the Catalogues and Specifications Reference Manual for details of command syntax.)



2.3



Status Bar The status bar displays messages, informing you of the progress of certain software operations, and prompts you to carry out actions. The Status bar is shown as the bottom line of the application window. If you are carrying out a series of tasks prompted by the Status bar, you must press the Escape key to inform the software when you have finished.



2.4



Menu Bar The menu bar is dockable: it may be "docked" to any edge of the application window or set to "float" at any position on the screen.



2.4.1



Administration You will see the following menu options only if you have administrative access rights.



2.4.2



Naming Format



Controls the automatic naming used for parameter descriptions.



Representation Rules



Defines the rules that determine the various levels of complexity available for displaying components in the graphical view.



Generic Types



Sets up a list of permissible generic types which may be allocated to new catalogue components



Menu Items The General Application menu is displayed when you first enter PARAGON. The options on this menu are also available in all discipline-specific PARAGON applications. •



PARAGON



•



Display



•



Query
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2.5



•



Settings



•



Utilities



•



Create



•



Modify



•



Delete



•



Window



•



Help.



CE Button Many forms that show the current attribute settings for an element incorporate a button labelled CE. To change the focus of such a form so that it displays attribute settings for a different element, navigate to the required element using the Members List and then click the CE button to reset the form to show the attribute settings for the new current element.



2.6



Create/Modify Option Button Most forms for defining element attributes may be used both for creating a new element and for modifying an existing element. Set the option button to Create if you are defining a new element or to Modify if you are redefining the settings for an existing element.



2.7



Lock Button Some forms let you set data values in text boxes by copying the corresponding attribute settings from cursor-picked elements. When set to On, the Lock button next to a data field inhibits updating of that field by cursor picking. Only those fields with their Lock buttons set to Off will be updated. This lets you copy settings from different elements by changing the Lock buttons between cursor picks. Note: Even if its Lock is On, you can always override the current setting of a text field by typing in explicit data.



2.8



Using a File Browser When you select an option which requires you to open or save a file, you will see a File Browser form. This provides an easy way of navigating around the operating system directory hierarchy. By default, the Directory Path will be that specified by the setting of the environment variable $PDMSUSER. This will normally be your home directory. Enter a different starting path if you wish. The Directories scrollable list shows all directories in the current directory path. The path ending /. represents the current directory; the path ending /.. represents the owner of the



© 2007 AVEVA Solutions Ltd



2:3



12.0



Catalogues and Specifications User Guide Getting Started



current directory (i.e. the next level up in the hierarchy). Select entries from this list to navigate up or down the hierarchy until you reach the directory containing the required file. By default (Filter set to *), the Files scrollable list shows all files in the current directory. To restrict the listed files to those of interest, enter a suitable expression in the Filter text-box using the following wildcard characters: * represents any number (including zero) of any characters ? represents any single character For example, the filter ABC* will list all files with names beginning with ABC, whereas ABC? will list only files with four-character names beginning with ABC. To specify an existing file for a load or save operation, select the file name from the Files list: its name will be copied into the File Entry text-box. To specify a new file name for a save operation, type the name into the File Entry text-box. The new file will be created in the currently selected directory. Click OK to action the file selection.



2.9



Ending your Session To leave both the PARAGON module, select Paragon>Exit. You will be asked whether or not you want to save any changes made since your last Save Work operation. Select Yes to update your current catalogue databases or No to ignore all recent changes. You will then leave and return to the operating system. To leave PARAGON and go to another module, refer to Switching Modules.
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3



Menus



3.1



Introduction PARAGON has a new set of applications to manage catalogue and selection data appropriate to each discipline. In the General application, a common set of menus are provided for non-discipline specific activities, as shown below. Individual applications add menus appropriate to the discipline. For example the Pipework Application additional menus are shown below. Several of the new applications use Selection Tables instead of Specifications. The options on the PARAGON menu bar will depend on the application that is currently selected. A selected item appears greyed out. •



General Menus



•



Pipework Menus



•



Steelwork Menus



•



Equipment Menus



3.2



General Menus



3.2.1



PARAGON The options on this menu let you change to other PARAGON applications, change to other functional modules, and save any catalogue changes made during your current session. Save Work



Updates the catalogue databases to save changes made during the current session. When you make changes to catalogue items during a session, the effects of your changes are applied only to a copy of the catalogue data until you update the database. You are advised to save your work regularly to avoid losing catalogue changes in the event of an unforeseen problem (such as a power failure or computer breakdown).



Get Work



Updates the catalogue databases to show changes made by other users during the current session.



Extract Control



Opens the Explorer Settings Form that lets you control data flow between extracts, if you are using an extract database.
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Session Comment



Opens the Savework / Session Comment Form, showing the changes made in this and previous sessions.



General



This item is greyed out within the non-discipline specific General application.



Pipework



Switches to the Piping application for designing Piping Components.



Steelwork



Switches to the Steelwork application for designing Structural Profiles, Joints and Fittings.



Equipment



Switches to the Equipment application for defining Equipment components.



Modules



Lets you switch to another functional module, or exit, with the option to save catalogue changes in your current databases before doing so. DESIGN



Restore Views – Reopens the module with the last view displayed Macro files – opens a confirmation box asking you to confirm that you wish to leave the current application and switch to the DESIGN module



SPOOLER



Restore Views – Reopens the module with the last view displayed Macro files – opens a confirmation box asking you to confirm that you wish to leave the current application and switch to the SPOOLER module



DRAFT



Restore Views – Reopens the module with the last view displayed Macro files – opens a confirmation box asking you to confirm that you wish to leave the current application and switch to the DRAFT module



ISODRAFT SPECON PROPCON LEXICON ADMIN Exit
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3.2.2



Display The following options are available:



3.2.3



Plot View



Opens the View Plotfile Form in which to display 2D plot files.



Members



Opens the Members Form, which provides a way to navigate around the database. The standard way to navigate is using the Explorer.



Advanced Members



Opens the Members Form, which lets you store a list of frequently accessed elements for rapid navigation.



Specifications



Displays the Specification List Form, showing a list of all currently available specifications, so that you can quickly navigate to any of them.



Command Line



Opens the Command Window, which lets you type in commands directly, and read the system’s responses, thus bypassing the forms and menus interface for the current application. For information about these commands refer to the Catalogue and Specification Reference Manual.



Catalogue Explorer



Opens the Catalogue Explorer Form that lets you access the catalogue, properties, DESIGN and DRAFT databases.



Query The following options are available: Attributes



Opens the Attributes Form that lists the settings of specified attributes for the current element.



Project



Opens the Query Project Form that lets you query your User Status, and List Teams, Users, Databases and MDBs, and Data Access Control.



User Status



Opens the User Status Form that lets you query the status of users.



Data Access Control



Opens the Query Data Access Control Form that lets you query the access rights of users.



DB Changes



Opens the DB Listing Form that lets you query all or part of the database, including element attributes and the changes since a given time.
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3.2.4



Settings The options on this menu let you define some default settings that are to be applied during your subsequent catalogue design activities. System



Displays the System Settings Form that lets you switch the audible alarm on or off; configure the tool bar and define how the windows act when they are activated.



Graphics



Opens the Graphics Settings Form that lets you define how pipework and steelwork are represented; whether insulation and obstruction volumes are also shown; specify the colours used for the current element, highlighting, etc. and set up defaults for the lengths that will be used to display p-points, p-lines and axes. Colour



Opens the Graphics Settings form at the Colour Tab.



Representation



Opens the Graphics Settings form at the Representation Tab.



Axes Height – Axes window



Opens the Axes Form that lets you define the axes height.



Naming



Opens the Naming Settings Form that lets you switch the Autonaming function on or off, define the Naming Rules (via the Naming Rules Form) and set the naming mode (Infill or Append)



Storage Areas



Opens the Storage Areas Form that lets you define the default area for files to be saved.



Model Parameters



Opens the Model Settings Form that lets you set default values for catalogue parameters and design parameters relevant to each type of component. These set the initial geometry etc. for newly created components so that they can be displayed in graphical views.



Comparison Date



Opens the Set Comparison Date Form that lets you set the Comparison Date to either an actual Time/Date or to an existing Stamp. Setting the Comparison Date enables you to produce reports or create expressions that use the Comparison Date.



Representation Rules



Opens the Drawing Representation Settings Form that let you define the rules that determine the various levels of complexity available for displaying components in the graphical view.



Generic Types



Opens the Generic Type Definitions Form that lets you set up a list of permissible generic types that may be allocated to new catalogue components



Reset Window Layout



Lets you reset the layout of windows to the layout that was displayed the first time you accessed this module during this session.



Explorer



Opens the Explorer Settings Form that lets you set the appearance of the Catalogue Explorer.
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3.2.5



Utilities The options on this menu give you access to the following utilities: Data Checker



Opens the Checker Form that lets you run a customised data check specific to your company or project requirements.



Autonaming



CE only



Automatically names only the current element.



CE Offspring



Automatically names the sub-elements of the current element.



Lists



Opens the Lists/Collections Form that lets you set up lists of elements which can then be handled as a single element, for positioning, orientation, etc.



Claimlists



Opens the Multiwrite Claimlist Form that lets you set up lists of elements that can be claimed so that only you can change them, if you are working in a multiwrite database.



DB Listing



Opens the DB Listing Form that lets you output all or part of the database, including element attributes, as a text file.



Reports



Lets you generate set up report templates and use them to produce reports. For more information, see Reports.



Run



Runs a report when you have a suitable report template set up



Create



Opens the New Report Template Form that lets you create a report template



Modify



Opens the Modify Report Template Form that lets you modify a report template.



Delete



Lets you delete a report template or a report.



Quick Reports



Lets you generate reports with basic formatting. Note that you cannot save the report template.



Surface Treatment



Define



Lets you define the surface parameters



Report



Opens the Surface Treatment Standard Report Form that lets you output reports, such as to a printer or as an excel file



Import Data



3.2.6



Opens the standard windows form as Import Data, that lets you select a comma separated value (csv) file to import.



Create The options on this menu give you access to the following utilities: Copy
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3.2.7



Modify The options on this menu let you make explicit changes to some attributes of the catalogue database elements. Name



Opens the Name Form that lets you change the name of an element.



Attributes



Opens the Attributes Form that lets you modify the attributes of an element.



Attributes Global Opens the Global Attribute Change Form that lets you modify the attributes of an element and all of its members. Like



Lets you set the attributes of one element to be the same as the attributes of another element. Current element



3.2.8



When prompted, use the cursor to pick all elements that are to have the same attribute settings as the current element.



Lock



Opens the Lock Form that lets you set/unset protection against attribute modification.



Hierarchy



Lets you reposition elements in a members list. Include



Opens the Include Form that lets you associate a member with sub-elements



Reverse Order



Displays the list in reverse order. If you change your mind, you can undo this operation by immediately repeating the command.



Reorder



Opens the Reorder Form that lets you move individual elements to specified positions in the members list



Delete The options on this menu let you delete specified elements from the catalogue database. Note: Each time you use a Delete option you must confirm (or cancel) the deletion. This is an important safety feature, since deleted elements cannot be restored. CE



Deletes the current element.



Name



Lets you delete explicitly named elements.



Members



Lets you delete all members or selected members of the current element without deleting the current element itself.
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Opens the Delete Selection Form that lets you select specific elements to delete.



All



Lets you delete all members of the selected element.
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3.2.9



Window These items are the standard Microsoft Windows options as used in all Microsoft Office products.



3.2.10



Help Most bar menus have a Help option on their right-hand side. Where available, online help gives detailed instructions on the use of the forms and menus via which you control each application. Pressing the F1 key at any time will display the help topic for the currently active window. Alternatively, search for the required form title using the Search tab on the tri-pane window. The Help option gives you the following choices from its sub-menu: Contents



This displays the Help tri-pane window with the Contents tab at the front so that you can find the required topic from the hierarchical contents list.



Search



This displays the Help tri-pane window with the Search tab at the front so that you can find all topics that contain the specified keyword(s).



About



This displays information about the version that you are using.



3.3



Pipework Menus



3.3.1



PARAGON The menu items are the same as those described in General Menus except that the Pipework item is greyed out.



3.3.2



Display The menu items are the same as those described in General Menus.



3.3.3



Query The menu items are the same as those described in General Menus.



3.3.4



Settings The menu items are the same as those described in General Menus.
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3.3.5



Utilities The menu items are the same as those described in General Menus with the addition of the following items:



3.3.6



Convert Spec



Opens the Convert Spec Form that lets you convert a Specification in to either a Spec World/Table Group or a Part World.



Modify Ckeys



Opens the Edit Ckeys Form that lets you set the new CKEY attribute on COCO elements for old databases.



Pconn/SKEY Report



Opens the PCONN/SKEY Compatibility Reports Form that lets you produce reports on pipe work specifications, detailing the SKEY and the PCONNS for each SPCOM.



Modify PconnsS



Opens the Modify Pconns Form that lets you modify the connection type defined on the Pconns.



Create The options on this menu give you access to the following utilities: Copy



Opens the Copy Element Form that lets you create a copy of an existing element. You can then modify the copy to produce a new catalogue item with a minimum of effort.



Catalogue



Opens the Create Catalogue Form that lets you create an administrative Catalogue (CATA) element. Note that you must be at World level to create a Catalogue.



Section



Opens the Create Section Form that lets you create an administrative Section (SECT) element.



Specification



World



Opens the Create Specification World Form that lets you create and name a new Specification World



Specification



Opens the Create Pipe Specification Form that lets you create and name a new Pipe Specification.



World



Opens the Create Table World Form that lets you define a name for a new Spec Table World



Spec Table



Size Range Table Opens the Create Nominal Bore Table Form that lets you define a name for a new Nominal Bore Table.



Part
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Opens the Create Branch/Reducer Table Form that lets you define a name for a new Branch/ reducer Table.



World



Opens the Create Part World Form that lets you define a name for a new Part World
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Hierarchy



Opens the Create Part Family Form that lets define a name for a new Part Family.



Family



Opens the Create Part Family Form that lets define a name for a new Part Family.



Category



Opens the Create Category Form that lets you create a Category (CATE) element for storing piping components. You can simplify the process by using a standardised category that uses a number of default settings. Ensure that you are at Section level.



Data Set



Opens the Create DTSE Form that lets you create a data set (DTSE), which is used to hold catalogue data that is not stored more specifically.



Text



Opens the Text Definition Form that lets you create a generalpurpose text element, which can hold textual data at many different levels in the database hierarchy.



Detail Text



Opens the Detail Text Definition Form that lets you create a detailing text (SDTE) element, which can hold a component description for use when compiling drawings, reports, material takeoff lists, etc.



Material Text



Opens the Material Text Definition Form that lets you create a material text (SMTE) element, which can hold a material description for use when compiling drawings, reports, material take-off lists, etc.



Draft Symbol Set



Opens the Draft Symbol Sets Form that lets you define symbols for components to be used on Draft drawings.



Bolt Table Utility



Opens the Bolt Table Utilities Form that lets you define the properties for the bolt tables.



Coco Table



Opens the Create Coco Table Form that lets you define the name, purpose and storage area for a new Coco table.



Nominal Dimension Table



Opens the Create Nominal Bore World that lets you set the name for a new Nominal Bore World



Elements Properties
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Lets you set the parameters of the current element



Opens the Properties Form that lets you create or modify property database elements, such as CMPD, TUBD etc..
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3.3.7



Modify The options on this menu let you make explicit changes to some attributes of the catalogue database elements. The menu items are the same as those described in General Menus except for the addition of the items below. Specification



Opens the Specification Form that lets you amend the details of a Specification.



Spec Table



Opens the Size Range Form that lets you amend the details of a Spec Table.



Part Family



Opens the Modify Part Family Form that lets you change the details of a Part Family.



Category



Opens the Model View Form that lets you modify a standardised Pipework Category (but not a general Category which has no members).



Data Set



Opens the Catalogue Property Definitions Form that lets you create a data set (DTSE), which is used to hold catalogue data that is not stored more specifically.



Text



Opens the Text Definition Form that lets you modify the text string stored in a general Text element.



Detail Text



Opens the Detail Text Definition Form that lets you modify the data stored in a detailing text (SDTE) element.



Material Text



Opens the Material Text Definition Form that lets you modify the data stored in a material text (SMTE) element.



Detail Plot



Opens the Detail Plotfile Form that lets you define the plotfiles associated with a catalogue element.



Draft Symbol Set



Opens the Draft Symbol Sets Form that lets you modify symbols for components to be used on Draft drawings.



COCO Table



Opens the Connection Compatibility Table Form that lets modify connection types.



Nominal Dimension Table Opens the appropriate table that lets you amend the nominal dimensions of the current element Properties



3.3.8



Opens the Properties Form that lets you create or modify property database elements, such as CMPD, TUBD etc.



Delete The menu items are the same as those described in General Menus.



3.3.9



Window The menu items are the same as those described in General Menus.



3.3.10



Help The menu items are the same as those described in General Menus.
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3.4



Steelwork Menus



3.4.1



PARAGON The menu items are the same as those described in General Menus except that the Steelwork item is greyed out.



3.4.2



Display The menu items are the same as those described in General Menus.



3.4.3



Query The menu items are the same as those described in General Menus.



3.4.4



Settings The menu items are the same as those described in General Menus.



3.4.5



Utilities The menu items are the same as those described in General Menus.



3.4.6



Create The options on this menu give you access to the following utilities: Copy



Opens the Copy Element Form that lets you create a copy of an existing element. You can then modify the copy to produce a new catalogue item with a minimum of effort.



Catalogue



Opens the Create Catalogue Form that lets you create an administrative Catalogue (CATA) element. Note that you must be at World level to create a Catalogue.



Section



Opens the Create Section Form that lets you create an administrative Section (SECT) element.



Category



Lets you create a Category (CATE) element. You can simplify the process by using a standardised category that uses a number of default settings.



Data Set
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for Profiles



Opens the Create Structural Category Form that lets you create a Profile category.



for Joints



Opens the Create Structural Category Form that lets you create a Joints category.



for Fittings



Opens the Create Structural Category Form that lets you create a Fittings category.



for Templates



Opens the Create Structural Category Form that lets you create a Template category.



Opens the Create DTSE Form that lets you create a data set (DTSE), which is used to hold catalogue data that is not stored more specifically.
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3.4.7



Text



Opens the Text Definition Form that lets you create a generalpurpose text element, which can hold textual data at many different levels in the database hierarchy.



Draft Symbol Set



Opens the Draft Symbol Sets Form that lets you define symbols for components to be used on Draft drawings.



Properties



Opens the Properties Form that lets you create or modify property database elements, such as CMPD, TUBD etc.



Modify The options on this menu let you make explicit changes to some attributes of the catalogue database elements. The menu items are the same as those described in General Menus except for the addition of the items below.



3.4.8



Category



Opens the Model View Form that lets you modify a standardised Steelwork Category (but not a general Category which has no members).



Dataset



Opens the Catalogue Property Definitions Form that lets you create a data set (DTSE), which is used to hold catalogue data that is not stored more specifically.



Text



Opens the Text Definition Form that lets you modify the text string stored in a general Text element.



Draft Symbol Set



Opens the Draft Symbol Sets Form that lets you modify symbols for components to be used on Draft drawings.



Properties



Opens the Properties Form that lets you change the properties of the current element.



Delete The menu items are the same as those described in General Menus.



3.4.9



Window The menu items are the same as those described in General Menus.



3.4.10



Help The menu items are the same as those described in General Menus.



© 2007 AVEVA Solutions Ltd



3:12



12.0



Catalogues and Specifications User Guide Menus



3.5



Equipment Menus



3.5.1



PARAGON The menu items are the same as those described in General Menus, except that the Equipment item is greyed out.



3.5.2



Display The menu items are the same as those described in General Menus.



3.5.3



Query The menu items are the same as those described in General Menus.



3.5.4



Settings The menu items are the same as those described in General Menus.



3.5.5



Utilities The menu items are the same as those described in General Menus.



3.5.6



Create The options on this menu give you access to the following utilities: Copy



Opens the Copy Element Form that lets you create a copy of an existing element. You can then modify the copy to produce a new catalogue item with a minimum of effort.



Catalogue



Opens the Create Catalogue Form that lets you create an administrative Catalogue (CATA) element. Note that you must be at World level to create a Catalogue.



Section



Opens the Create Section Form that lets you create an administrative Section (SECT) element.



Category



Opens the Create Category Form that lets you create a Category (CATE) element. You can simplify the process by using a standardised category that uses a number of default settings. for Component



Opens the Create Category Form that lets you create a Component category.



for Templates



Opens the Create Category Form that lets you create a Template category.



Selection Table Spec World Table Group
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Opens the Create Specification World Form that lets you create and name a new Spec World. Opens the Create Table Group Form that lets you create and name a new Table Group.
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Part



3.5.7



World



Opens the Create Part World Form that lets you create and name a new Part World



Hierarchy



Opens the Create Part Family Form that lets you create and name a new Part Family.



Family



Opens the Create Part Family Form that lets you create and name a new Part Family.



Text



Opens the Text Definition Form that lets you create a general-purpose text element, which can hold textual data at many different levels in the database hierarchy.



Draft Symbol Set



Opens the Draft Symbol Sets Form that lets you define symbols for components to be used on Draft drawings.



Properties



Opens the Properties Form that lets you create property database elements, such as CMPD, TUBD etc



Modify The menu items are the same as those described in General Menus except for the addition of the items below.



3.5.8



Selection Table Group



‘Opens the Selection Table Form that lets you control all the data required to define a Selection Table.



Part Family



Opens the Modify Part Family Form that lets you change the details of a Part Family.



Category



Opens the Model View Form that lets you modify a standardised Equipment Category (but not a general Category which has no members).



Text



Opens the Text Definition Form that lets you modify the text string stored in a general Text element.



Draft Symbol Set



Opens the Draft Symbol Sets Form that lets you modify symbols for components to be used on Draft drawings.



Properties



Opens the Properties Form that lets you create or modify property database elements, such as CMPD, TUBD etc



Delete The menu items are the same as those described in General Menus.



3.5.9



Window The menu items are the same as those described in General Menus.



3.5.10



Help The menu items are the same as those described in General Menus.
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4



Forms



4.1



Attributes Form This form lets you change the attribute values of an element.
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Lists the attributes of the selected element in a grid. Selecting a row in the grid and selecting an option from the shortcut menu gives the Attribute, Description, Data Type, Sort by Attribute and Pseudo Atts options. Selecting one these option will give more information in the grid, which will remain until the option is selected again. If the Track current element check box is selected, the listed attributes will be updated as different elements are selected in the Members List.



4.2



Axes Form This form allows you to set the Axes height for the current element.



Type a valid size and select the OK button to save the value.



4.3



Bolt Table Utilities Form This form lets you create and modify Bolt Tables.



Use the Create menu option to create a new Bolt Table or the Modify menu option to amend an existing Bolt Table.



4.4



Catalogue Explorer Form The Catalogue Explorer form provides access to the catalogue, properties, DESIGN and DRAFT databases. This allows references to be made to other catalogue elements, properties elements, design templates, and draft symbol sets. It acts as a browsing and selection mechanism for items in the catalogue databases.
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The Catalogue Explorer is similar to the explorer control currently used in the DESIGN and DRAFT applications, in every way apart from the following items. •



It displays more than one database world type at a time. It can include the DESIGN, DRAFT, Catalogue and Properties worlds as root nodes at the same time.



•



It displays an extra sub level showing the actual dbs that make up the database worlds to help differentiate where the catalogue data is being created, modified or browsed from.



You are able to see worlds of the type DESIGN, DRAFT, Catalogue and Property if they have the correct privileges to view them. Expanding one of the individual db world nodes will show the contents of that particular db in the same way you would normal expect from the existing Explorer Controls in DESIGN and DRAFT. You can then make use of the existing PARAGON functionality to modify and view the attribute data. You will also have use of the existing Explorer controls context menu’s to manipulate the items as shown below:
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4.5



Catalogue Property Definitions Form This form lets you create (or modify) a catalogue properties dataset.
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The upper part of the form lets you specify the details for a single property, while the lower part displays a list of all of the properties that are currently defined. When modifying a dataset, the CE button reinitialises the form to modify the DTSE element currently selected in the Members form (see Members Form). The name of the dataset to be modified is displayed adjacent to the CE button.



4.5.1



4.5.2



Property Frame



Description



Any text description (must not include quote marks)



Key



a four-letter code for the property used to identify property in reports or rules. (Stored in DKEY attribute of DTSE)



Definition



specifies how the value of the property will be derived when the template is used in a design. The choices are: Null:



No Value. Use if you are defining a dataset for purposes other than creating Catalogue properties.



Design Parameter:



Value taken from Design parameter data



Parameter:



Value taken from Catalogue parameter data



Attribute:



Value taken from named attribute. In this case Key must be a valid attribute, for example DIAM for Diameter



Expression:



Value is result of evaluating expression (as typed into textbox immediately below the option list)



Plotfile:



Name of Plotfile to be displayed



No



the parameter number.



Display



determines whether or not the value of this property will be shown on the data-entry form when the template is instanced in a design.



Data Frame



Type



lists relevant options for the selected Definition, for example Landscape or Portrait for a Plotfile, or Distance, Bore, String etc. for a Parameter.



Default



lets you specify a value which will be used if the correct value cannot be derived at any intermediate stage of the design process. If Plotfile is selected as the property Definition, this field will appear as Sub-Dir. Requires a value (e.g. 1500) or a valid expression (e.g. LENG * 2.0). For Sub-Dir, no spaces are allowed.



Expr



(if an Expression Definition is selected) or File if a Plotfile Definition is selected. Requires a valid expression or a filename (spaces not allowed) as appropriate.
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The Current Data Elements frame lists the currently data elements in Type order, displaying the Type (Definition), Key, Description and Default. Selecting a list member will populate the upper half of the form with the information held for the selected element.



4.6



Include



adds a new data element to the list.



Replace



allows you to modify the currently selected data element.



Remove



removes the currently selected data element from the list.



Category Form Categories are managed via the new Category form. Multiple versions of this form can be shown concurrently, allowing different categories to be viewed simultaneously.
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The Category form displays and allows you to edit all the data associated with a category of catalogue components, including: •



point sets



•



geometry sets



•



data sets



•



bolt sets.



If geometry is available, the component is displayed in the graphical view and gadgets are provided to change the graphical representation. Selecting a line in the Model Operations list controls what data is displayed in the lower panels.



4.6.1



Category Listing First is the Category listing of components, as shown above. This allows components to be added to or removed from the category, and individual parameter values can be edited in the grid (note that you must move focus off a grid cell in order to cause it to be updated to the database). Parameters for the category are displayed in the Parameter Definition list.



Selecting a parameter in the Parameter Definition list allows you to edit that parameter definition. Parameters can also be added to, removed from, or reordered in the list.



4.6.2



Component Panel Second is the individual component panel. This allows you to set attributes and references on the individual component. If other attributes are to be modified, this can be achieved using the General Attributes form invoked via the Edit All Attributes button.
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Reference element names can be entered directly into the text gadgets or appropriate reference elements can be searched for using the Search buttons which will display a list in a search panel, after “find” has been pressed, the type of results can be affected by manipulating the settings on the form.



4.6.3



Point Set



Third is the point set. This allows you to create, modify and delete individual ppoints of the various types (see detail of drop down list to right).



© 2007 AVEVA Solutions Ltd



4:8



12.0



Catalogues and Specifications User Guide Forms



4.6.4



Geometry Set Fourth is the geometry set. This allows you to create positive and negative geometry, deletion is also possible for nominated geometry elements.
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4.6.5



Data Set Fifth is the data set. This allows you to select, modify, add and delete individual data elements in the dataset.



4.6.6



Bolt Set Sixth is the bolt set: This allows you to select, modify, add and delete individual bolts in the bolt set.



4.7



Checker Form This form lets you run a customised data check specific to your company or project requirements.
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1. Use the Check Items list to specify which elements you want to check. Use the Add and Remove menu options to edit this list. 2. The check functions available to you are categorised into Classes (each typically representing a main discipline) and Groups (each typically representing a specific feature of a discipline). Select the required class, then the required group. The Checks list will now show all individual checks applicable to that class and group. 3. From the Checks list, select one or more checks (pick a check to select it; pick it again to deselect it). 4. To make it easier to interpret the check results, you can highlight particular elements in the graphical view. To do so, use the Highlight menu options. 5. Click the Check button run the selected checks on the specified elements. The results of the checks (passes and failures) will be listed in a Checker Results form which is displayed automatically. 6. To save the check results to a file, or to reload a list of failed elements from a previous check, use the Control menu options.



4.7.1



The Checker Form Control Menu These options let you save your check results to a file, or reload such a file. They work as follows: Save>Results



saves both passed and failed results



Save>Failed Reference



saves the database references of elements that have failed, together with the checks performed. This makes it easy to recheck the failed elements later.



Load>Failed Reference



reloads a list of failed element references (saved using the preceding menu option)



In each case, use the displayed File Browser to specify the required file name and location.
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4.7.2



The Checker Form Add/Remove Menus These options let you edit the Check Items list to show those elements on which you want to run data checks. The Add options are: CE



adds current element



CE Members



adds members of current element, but not the CE itself



Pick



not applicable to SPOOLER



Failed List



adds all elements listed as having failed a preceding check (useful for rechecking items after correcting data)



List list_name



adds all elements in named list



The Remove options are:



4.7.3



All



empties the list



Selected



removes items currently selected in list



CE



removes current element



CE Members



removes members of current element, but not the CE itself



Pick



lets you remove items by picking them in a graphical view, using any EDG options



List list_name



removes all elements in named list



The Checker Form Highlight Menu These options let you highlight elements relevant to the data checks. They work as follows: Elements



highlights all elements which are in the Check Items list. When you select this option, you will see an Elements Colour form which lets you choose the highlight colour. Note that only elements already in the Drawlist will be highlighted; elements are not added to the view automatically.



Passed (on/off toggle)



highlights all elements which pass subsequent checks. Set colour using Highlight> Colours> Passed option.



Failed (on/off toggle)



highlights all elements which fail subsequent checks. Set colour using Highlight>Colours>Failed option.



Clear



unhighlights current element only (CE), or everything in graphical view (All).
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4.7.4



The Checker Results Form Displayed automatically when you run a data check. •



The Passed list shows those elements which have passed all specified checks.



•



The Failed list shows those elements which have failed one or more checks, with a brief description of the reason for the failure.



Click on an element in either list to navigate to that item; typically to correct the reason for the failure before repeating the checks.



4.8



Choose Referenced Attributes for Form Choose Referenced Attributes when invoked from the Referenced Attributes button on the Search Result Presentation Settings window.



Element Tree



Element tree displays attributes that are available either through the owning hierarchy of the result elements or references from the results elements.



Owning Elements



Allows the valid owner elements to be browsed and any of their attributes, to be selected, including elements of attributes referenced from them. Owning elements are included both using the OWNER reference and also using their actual element type. So for example the SPEC associated with a SPCO is shown as SPEC and choosing for example SPEC.NAME will give the spec name associated with the SPCO.



© 2007 AVEVA Solutions Ltd



4:13



12.0



Catalogues and Specifications User Guide Forms



Referenced Elements



Allows the valid referenced elements to be browsed and any of their attributes, to be selected, including attributes of elements referenced from them.



Selected Attribute



Shows the currently selected attribute in the element tree. This can be edited by you if required.



Selected Attributes List



List of referenced attributes to be included in the results grid. Whenever the Search Result Presentation Settings dialogue window is displayed this list will include any referenced attributes previously selected to include in the results grid. Attributes are normally added using the Add button but can also be can be edited by you if required.



Add ->> Button



Adds the current attribute within the element tree to the Selected Attributes list. Enabled if the current location in the Element Tree is a referenced attribute.



button. To add all of the connection types select the Add All>> button. Select the Create/Modify Coco Description button to display the COCDES Form that lets you define a long description for the Coco. To remove items from the Coco’s table, highlight the item(s) and select the Remove< button. To clear all of the items in the table select the Remove AllChanges. This option is useful after a Getwork to see the changes that other users have made. Apply is only active when there are elements in the Elements list. The Dismiss button dismisses the form and clears the Elements list.



4.31.5



Control Options on the DB Changes Form The menu options under Control on the DB Changes form are as follows:



4.32



Clear Output



Clears the Command Output form used when Destination is set to Screen.



DB Listing



This outputs a listing of the specified parts of the database in its current state.



DB Changes



This outputs a listing of the changes to the specified parts of the database as a macro which can be run in to return the database to the state it was in at the given time or session. You can edit the macro file so that only the required elements are changed.



DB Differences



This outputs a listing of the specified parts of the database, with the old and new elements and attributes changed or added since the given time or session.



Output>Options...



Displays the Output Options form.



Output Backtrack Mode



Is only active in DB Changes mode. This option controls the style of the output information. If on, then the output can be run as a macro which will return the database to the state it was in at the given time or session. If off, then the output is a report on the changes made since the time or session.



DB Listing Form This form lets you manage the details of the system databases.
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4.32.1



Add/Remove Options The menu options under Add and Remove on the Database Listing form are used to add and remove elements from the Elements list. The Remove option is only active when there are elements in the Elements list. CE



adds or removes the current element.



CE Members



adds or removes the members of CE, but not CE.



Pick..



Only active in DESIGN. Allows you to add or remove elements by graphical picking using event driven graphics.



List



adds or removes all elements in the selected lists. Lists are created using the Lists/Collections form.



In addition, the Remove option has the following:
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4.32.2



All



removes all elements from the Elements list.



Selected



removes all items selected in the Elements list.



Colour Options The menu options under Colour on the Database Listing form are only active when there are elements in the Elements list. Highlight>Elements



shows a Colour Selection form. When a colour is picked, the contents of the Elements list will be highlighted in that colour, in all the graphical views. Only elements already in the Drawlist will be highlighted; elements are not automatically added to the Drawlist.



Highlight>Changes/ Differences



This option will be Changes or Differences according to the form mode. It is not available at all in DB Listing mode. This option shows a Colour Selection form. When you press the Apply button, the colour picked will be used to highlight any elements that have changed.



Unhighlight



4.32.3



Unhighlights the CE only, the Elements in the list or All elements in the graphical views.



Query Options The options under Query on the menu on the Database Listing form are as follows. Note that output from Queries is always output to the screen, and also output to file if the Destination selection is File. The file will contain comment lines, which start with -- so that it can be run in as a PDMS macro. •



Query >Clock outputs current Time and Date



•



Query >CE and Query >Elements



These options have the same submenu. The options under CE output information about the current element, and the options under Elements output information about all the elements in the Elements list on the form. Querying extremely long Element lists can take a long time. •



Session outputs.



•



Element name



•



DB name



Last saved session number and the date, user and description (session comment) for that session. •



Last Modified outputs



•



Element name



•



DB name



The session that each element or any of the hierarchy below it was last modified, the date of the modification and the modifying user.
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This operation could be a time consuming operation if the CE is a DB world element or a large site, or other top-level element, and so you will be asked to confirm that you really wish to do this operation.



4.33



History



This is similar to the Last Modified Query, but gives the information for every session in which the element was been created or modified. You will be asked to confirm the query for top-level elements.



Claimed by



This outputs the name of the user who has the current element claimed out for modification. This is Unset if no user has the element claimed.



DB Name/Mode



This outputs the name, DB name, the DB access mode (RW, R, Multiwrite ) and the claim mode (implicit, explicit).



Define Rules Form Elements can be autonamed from the Create forms (provided an applicable naming rule has been defined), or if unnamed they can be autonamed subsequently from the Utilities menu.



In the definition fields define a new rule and select the Include button to add it to the list.
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4.34



Delete Selection Form This form lets you delete members from an element.



Select a member from the list and select the OK button to remove the member from the current element.



4.35



Detail Plotfile Form This form lets you display an isometric plot of a Branch containing the Component to be modified (if such a plot exists).
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The name of the currently selected Catalogue element will appear at the top of the form. Detail Plotfile lists the Components for which Pipe Isometrics have been produced. The appropriate isometric Plotfile that has been produced can be navigated to using the Browse button. Selecting the Plotfile and clicking OK on the resulting File Browser form displays the isometric plot in the bottom half of the Detail Plotfile form. Applying the Detail Plotfile form adds the currently selected Component to the Detail Plotfile list for future selection.



4.36



Detail Text Definition Form This form lets you define the default text descriptions that appear against generic type text.



© 2007 AVEVA Solutions Ltd



4:34



12.0



Catalogues and Specifications User Guide Forms



The three text-boxes at the bottom of the form, labelled Detail (ISODRAFT), (Interface B) and (Interface C), let you enter text strings for use in ISODRAFT and up to two other interfaced programs. (The labels on the last two gadgets may have been customised on your installation to identify specific programs used by your company.) Type the required text string(s) into the boxes. Each text string is restricted to a maximum of 120 characters. Note: Do not enclose the text between apostrophes (as is the standard PDMS convention) unless you want these to form part of the text string. You can specify the SKEY setting in either of the following ways: •



From the Generic Type list, select the component type to which the description applies. The Description list will show all available options for that component type; select one and the Symbol Key box will display the appropriate SKEY automatically.



•



Type the SKEY directly into the Symbol Key box. The Generic Type and Description lists will show the corresponding selections. (If the SKEY is not recognised, you will see an error message.)



•



If required, type the Material Take-off Length (MTOL) data in the Length box and the Material Take-off Quantity (MTOQ) in the Quantity box.



•



Detail Text (SDTE) elements are normally used to store descriptions of piping components for use by the isometric drawing module ISODRAFT. You may, however, use them for structural items if you have a special need to store such data.



•



If possible, a new SDTE will be stored as defined by the Reference Data settings; if no such area is set, navigate to the required element.



Note: The wording on the Detail Text Definition form reflects its intended use for piping components, so you must be careful to enter your structural data in such a way that you will be able to retrieve it as required.
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4.37



Draft Symbol Sets Form This form lets you define symbols for components to be used on Draft drawings, can be created and modified using the new Draft Symbol Sets form, available from the Create and Modify menus.



Draft Symbol Sets own a number of Draft Symbol Links (DRSYLKs). These can be added to or deleted form the list using the buttons provided. Selecting a DRSYLK in the list allows its attributes to modified in the lower panel of the form. Draft Text or Symbol Templates (TXTM or SYTM elements) can be referenced by typing in their names, navigating to them and clicking CE, or clicking the Search button to invoke the Search form. The Criteria expression determines which Draft views the symbols will be used on. An expression can be typed into the combo gadget, or an existing expression can be selected from the drop down list. Clicking on a Draft Symbol Link in the list will add its Criteria expression to the combo, so that all expressions accessed during the current session are available.
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4.38



Drawing Representation Settings Form (System Administrator only) This form lets you define the appearance of a component, as displayed in a 3D graphical view depending on the following drawing representation settings: •



The range of drawing levels to be shown



•



The obstruction level



•



The centreline flag



•



The tube flag



For convenience, you can define representation types, each corresponding to a given combination of these representation settings. Users can then reference such a type to change the appearance of a displayed component. To edit the current list of available representation types, select Settings> Representation Rules. You will see a Drawing Representation Settings form. The vertical lists near the bottom of the form show all the representation types currently defined, while the upper part of the form lets you edit the lists by adding, removing or modifying individual entries. The File entry near the top of the form shows where the current type set, as listed on the form, is stored. Each representation type is defined by the following settings: •



A keyword



•



A description



•



A drawing level range
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•



An obstruction level



•



The centreline flag



•



The tube flag



When you have finished with the Drawing Representation Settings form, select Control>Close from its menu to remove it from the screen.



4.39



Edit Ckeys Form The CKEY attribute can be set for each pair of connection types in the COCO elements in the CCTAB tables. It is used by SPOOLER to determine what type of connection is used to join two elements(e.g. Butt weld, Screwed, etc.). Note: Projects upgraded from pre version 11.2 require the Ckeys to be set on the COCO elements if they are to make use of SPOOLER.



To modify the Ckeys: 1. Navigate to the required CCTAB in the members list and select Utilities>Modify Ckeys, the Edit Ckeys form is displayed. 2. CE button - Displays all the connection types, in that table, in the scrolling list. You can optionally filter this list to just show the connection types of interest. 3. Select the required connection types from the scrolling list and click the Modify Ckeys button. Use the Select All button to select all entries in the list and the Unselect All button to deselect all entries in the list. 4. Select the required CKEY from the drop down list and click OK. 5. Dismiss the Edit Ckeys form when you have finished the changes.
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You can also remove selected COCO elements from the table, by selecting them and clicking the Delete button. A confirmation dialogue is displayed.



4.40



Explorer Settings Form This form lets set how the Catalogue Explorer (see Catalogue Explorer Form) will appear.



Select the appropriate tree settings and the individual settings for DESIGN and DRAFT. Select the OK button to save the settings.



4.41



Extract Claim List Form The Refresh button updates the form for the current element, shown below the button. Number of results per page can be set to 10, 20, 50 or 100. This selects the number of elements displayed in the scrolling list, which shows a list of all elements claimed to an extract DB in the current element hierarchy. The arrow buttons < > are used to page backwards and forwards through the list, respectively. If the World element is selected, all elements claimed to all extract DBs in the current MDB are listed. Picking an element in the results window will make the selected element the Current Element. The scrolling list shows a hierarchy of elements. Selecting an element in this window will make it the current element. The codes in front of the elements describe the extract claim state: C



Element is significant and claimed to an extract in this MDB



M



Element is significant and it, or one of its non-significant children, has been modified in an extract in this MDB



X



Element is claimed from an extract in this MDB, so changes to this element cannot be issued or aborted.



V



Element has been modified in a Variant extract in this MDB
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No code means that the element is either a non-significant element, or it has not been claimed to an extract in this MDB. When an element is marked CM, changes to the element can be flushed, issued or aborted.



4.42



Extract Data Control Form This form is only available if there is an extract database in your MDB. The scrolling list displays a database members list which shows the hierarchy of database elements around a selected element along with information about the extract claim status of each element. The element hierarchy shown on this form is not the complete element hierarchy as shown in the Members list: only significant elements are shown (or elements which own significant elements) because extract operations only apply to significant elements. Changes to elements selected from this list can be Flushed, Issued or Aborted (dropped) by pressing the appropriate button at the bottom of the form. Get Other Users Changes



refreshes your view of data in databases which own extracts in the current MDB.



Update for Current Element



When you press this button, the list of elements is updated to show the extract element hierarchy for the current element. This button may be used to bring up-to-date the information shown on this form if displayed data has changed since the form was last shown or updated.



Scrolling list



Shows a hierarchy of elements. Selecting an element in this window will make it the current element. The codes in front of the elements describe the extract claim state:



C



Element is significant and claimed to an extract in this MDB



M



Element is significant and it, or one of its non-significant children, has been modified in an extract in this MDB



X



Element is claimed from an extract in this MDB, so changes to this element cannot be issued or aborted.



V



Element has been modified in a Variant extract in this MDB



No code means that the element is either a non-significant element, or it has not been claimed to an extract in this MDB. When an element is marked CM, changes to the element can be flushed, issued or aborted. If the World element is selected, then all changes made in all extract databases in the MDB are selected for the Flush/Issue/Drop operation. Operate on



Can be set to Element Hierarchy, in which case Flush/Issue/Abort will work on the selected element and all elements that it owns directly or indirectly, or to Single Element in which case Flush/ Issue/Abort will work on the selected element only.



Flush



Updates the database owning the extract. Extract claims for selected elements are retained. A single element, or part of the hierarchy will be flushed, depending on the Operate on setting.
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4.43



Issue



Updates the database owning the extract and release the extract claim. A single element, or part of the hierarchy will be issued, depending on the Operate on setting.



Abort



Drops changes made to selected elements in extracts in this MDB and releases extract claims.



Show Extract Data List



Displays the Explorer Settings Form.



Generic Type Definitions Form Structural Profiles, Joints and Fittings in the catalogue have a Generic Type (Gtype) attribute that is set to a World. When a user selects a catalogue item via a Specification, this Gtype may be used as a filter to ensure that only items suitable for the desired function are made available.



The main area of the form is a multi-line text-box (or text pane gadget) which you can edit in any of the standard ways. Use the Generic Type option button to select the overall class of catalogue item, then edit the corresponding list of Gtypes as required. Ensure that each Gtype word occupies the first four columns and that the description begins in the sixth column. Click Apply to save the updated list. The new entries will be shown when a Gtype selection is made in any later step.



4.44



Global Attribute Change Form This form lets you modify the attributes of several elements simultaneously by specifying that the changes are applied below a specific hierarchic level. For example, you might want to change the Obstruction Level (OBST) settings for all primitives that represent a component's geometry.
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The element identified near the top of the form is that below which elements are to have their attributes changed (if you wanted to change attributes for that specific element, you should have selected Modify>Attributes rather than Modify>Attributes Global). If you want to change attributes below a different element, navigate to it in the Members List and click the CE button. The form will initially list the attribute types (but not their settings) for the current element. Navigate to an element below that which you have just specified and which has an attribute of the type which you want to change. Click the Attributes button. The list will now show the attribute types for this lower level element. Select the attribute type whose setting you want to modify. •



To change the setting of all elements which have the selected attribute, click the All attribute data button and enter the new setting in the With text box.



•



To change only those settings which already have a specified value for the selected attribute, click the other button and enter the relevant current setting in the adjacent text box. Enter the new setting in the With text box. For example, you might change to only those OBST attributes which are currently set to. Click Apply to make the changes.



For more information on element attributes, see the Catalogues and Specifications Reference Manual. Note: The change will be applied to all elements below the specified level that have the selected attribute type. For example, if you pick a DISH and change the DIAM attribute, this change will be applied to all primitives which have a diameter setting (CYLI, SLCY, etc.); not just to Dishes.



4.45



Graphics Settings Form This form lets you define the different colours that are used to display the current element, the active element and other visible elements.



4.45.1



Colour Tab This tab lets you set the colours that are used within the plotfiles and 3D views to indicate different elements of the design.
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4.45.2



Representation Tab This tab lets you set some of the general and piping representation parameters and presents control buttons allowing you to display further forms for specifying the representations of more specific parameters.



4.46



Hierarchy Form This form is used to specify which part of the hierarchy you want to report on.
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There are several methods available. 1. You can specify that only parts of the database under given owning elements will be included. Specify an owning element by making it the current element and pressing Add CE. The element's name will be displayed in the scrolling text box. You can specify several owning elements. Remove an element from the list by highlighting it in the list and pressing Remove. When you press Apply on the form, the names of the elements will appear in the Hierarchy option on the New/Modify Report Template form. Note: Specifying elements using this option will override anything you specify in the Volume or From option. 2. If you leave the Hierarchy option empty, you can specify a Volume, and report on elements Completely within or Partially within it. Selecting Completely within or Partially within option will display the Report Volume form. Note: Specifying a Volume will select elements from the whole MDB. The other From options cannot be used. 3. If you leave the Hierarchy option empty and do not specify a Volume, you can use the From option. You can specify:



4.47



•



MDB, which will select all elements in the database within the volume.



•



Drawlist, which will select all elements in the Drawlist within the volume.



•



Obstruction list, which will select all elements in the obstruction list within the volume.



Include Form This form lets you move elements from the members list of one owner to that of another.
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Near the top of the form is shown the name of the element whose members list is to be modified by the inclusion of new elements (we will refer to this as the new owner). Below this are two scrollable lists: •



Members (with its associated Goto button etc.) lets you navigate around the hierarchy just like the standard Members List.



•



Included Members shows the current list of members already owned by the new owner.



Use the form as follows: 1. If necessary, use the Members list or Navigation menu to navigate to the element that is to be the new owner and use the CE button to reset the form (the Included Members list will be updated automatically). 2. In the Included Members list, select an element adjacent to the required insertion position. Set the Before Item/After Item option button to specify the exact position relative to the selected member. 3. Select the element(s) which are to be included as members of the new owner in one of the following ways: Navigate to the required element in the Members list and set the option button below that list to CE or CE Members, depending on precisely which elements you want to move. Set the option button to ID Cursor or *ID Cursor and, when prompted, use the cursor to pick the elements in a graphical view. ID Cursor lets you pick one element; *ID Cursor lets you pick several elements (click Cancel when you have finished). 4. Click the Include button to move the selected elements to the new location. 5. When you have finished with the form, select Control>Close to remove it.



4.48



Intro Form This form lets you type, within a free-text field, introductory text to accompany the new report.
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4.49



Layout for Column n Form This form lets you specify how the report will display by allowing you to set the layout, the way that numbers appear, how text will display and how the heading will appear.



4.49.1



Layout You can specify:



4.49.2



•



The number of Spaces before column.



•



The Column width in characters. If you do not give a value, the width of the widest entry will be used.



•



The Justification (Left, Centre or Right).



•



Numeric Display



•



Remainder can be:



•



Decimal, in which case you can specify the number of Decimal places or



•



Fraction, in which case you must specify the Denominator. In the output, the denominator will be reduced if possible.



•



Style. This only affects how feet and inches are displayed.



•



Leading zeros can be on or off.



Text Display You can specify the characters used to specify Unset text.
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•



Headings can be On, Off or Page.



•



Heading Text can be set to:



•



4.49.3



•



Expression Text which will use the expression entered in the Expression text box on the Creating Column form.



•



Default which will use the full attribute name is possible. For example, if you enter POSI in the Expression text box, the column heading will be POSITION.



•



Custom, in which case you should enter the text required in the text box.



Values can be: •



On. The result of the expression (entered in the Expression text box on the Creating Column form) will be shown for every element that passes the selection criteria.



•



Off. No values will be shown. This can be used for reports in which only subtotals or totals are required.



•



1st. If this column is sorted, this option can be used to display only the first occurrence of a particular expression result.



•



Sub. A value will only be output in this column when a subtotal appears in one of the other columns



Subtotals Can be On or Off. Subtotals can only be produced for columns containing numeric data.



4.49.4



Totals Can be On or Off. Totals can only be produced for columns containing numeric data.



4.50



Lists/Collections Form You can define temporary lists of elements which can be positioned, orientated, deleted, etc. Lists are not saved when the current session ends. The current list is shown in the box, immediately to the right of the tool bar buttons, it can be changed by selecting another list from the drop-down list.
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To create, delete or change a list: •



Select Utilities>List. A List/Collections form will be displayed.



To create a new list: •



Select Add>List and type a description into the Description text box.



The text you enter will be displayed in the List drop-down list box. When you have created a list, you can add elements to it by selecting the other options under Add on the menu: •



CE



•



CE Members



•



Identified - Use the cursor to pick the items then press the Escape key when the list is complete.



•



Selection - Displays the Add to List form.



The Format drop-down list controls how the list items will be displayed: •



Name



•



Name & Description - can be displayed if a Description has been set



•



Description - can be displayed if a Description has been set



If the Highlight On check box is selected, items selected for the list are highlighted in the graphical view. You can remove elements from the list using the options under Remove on the menu: •



CE



•



CE Members



•



Identified - Use the cursor to pick the items to remove, then press the Escape key when you have finished.



•



From List - Select the items in the list.



•



All



•



Selection - Displays the Remove from List form.



•



List - Removes the list itself.



You can give commands that will act on the current list: type the command into the text box at the bottom of the form and select the Action button. See the DESIGN Reference Manual for information about commands.



4.51



Lock Form This form lets you lock any catalogue element to prevent it from being modified or deleted. No changes to the element are then possible until it is subsequently unlocked.
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Use the option button to specify the action required. The choices are: •



Lock CE - Locks current element only



•



Lock CE and below - Locks current element and its members



•



Unlock CE - Unlocks current element only



•



Unlock CE and below - Unlocks current element and its members



Click Apply to change the current protection.



4.52



Material Text Definition Form This form lets you modify any special information for a structural item that has been stored in a material text element.



Remember that the SMTE elements may be stored in a common area, as defined in the Quick Reports Form, rather than under individual component categories. The three text-boxes labelled Material (ISODRAFT), (Interface B) and (Interface C), let you enter text strings for use in ISODRAFT and up to two other interfaced programs. (The labels on the last two gadgets may have been customised on your installation to identify specific programs used by your company.) Type the required text string(s) into the boxes. Each text string is restricted to a maximum of 120 characters. Note: Do not enclose the text between apostrophes (as is the standard convention) unless you want these to form part of the text string.



4.53



Members Form The Members list lets you navigate to an element, thus making it the current element.
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Click on an element in the scrollable list. The picked element will become the current element and will be highlighted in the list. The element's owner and its members will also be displayed in the list. To go to a named element, type the name in the text box immediately below the form's menu bar and press Enter. You can enter a full name; for example:



zone 2 of site /TESTSITE The and controls let you move across the database hierarchy at the level of the current element. For example, if you have the following hierarchy: ZONE1 EQUIP1 EQUIP2 . . . CYLI1 DISH1 DISH2 . . . and EQUIP1 is the current element, selecting will move to EQUIP2. The Goto menu also lets you navigate across the database. The Control menu on the Members list lets you:



4.53.1



•



switch to an Advanced Members list which lets you store a list of elements which you access frequently. The elements can be accessed quickly by picking them in the list.



•



resize the Members list.



•



view extract claims relating to specific elements, using the Extract Claim List form.



Advanced Version of the Members Form The Advanced Members list is similar to the standard Members list, except that there is a Memory scrollable list at the bottom of the form, allowing you to store a list of frequently accessed elements. The elements can then be accessed quickly from the list. To store the name of a given element, select the element in the Members list, then click the Add button. The element will appear in the Memory list at the bottom of the form. To access the element later in the PARAGON session, click on it in the Memory list. The Memory list will be emptied when you leave PARAGON. To remove an element from the Memory list, select the element in the Memory list and click the Remove button. To remove all elements from the Memory list, click the Clear button
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To return to the standard Members list, select Control>Standard.



4.54



Model Settings Form When you create a new component that uses design data attributes or parameters as part of its definition, default values must be applied immediately if the component is to be represented in a graphical view. Design data attributes have initial defaults that you can change; parameters must have their defaults set for the appropriate type of component.



The left-hand part of the form shows the current design data attribute defaults for piping components. These have standard default settings. Change any of the displayed settings as required. The right-hand part of the form lets you set default values for any relevant types of parameter. Use the option button at the top to choose the required parameter type; any current settings will be shown in the scrollable list. Change existing settings, or set new parameters, in either of the following ways: •



To set parameters individually, enter a parameter number and its required default setting in the text-boxes below the list, then select Insert to transfer the new setting to the list.
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4.55



•



To copy parameter settings from an existing catalogue or design item, navigate to an element which has the parameter settings you want to use and select Use CE to copy these to the current list.



•



To reset all standard defaults, click the Default button. This sets all design data attributes to their standard settings and (CAUTION) clears all design parameter settings.



Model View Form This form lets you change the p-point set reference, the geometry set reference or any of the parameter descriptions for a standardised Pipework component category.



If you intend to retain an existing p-point set or geometry set reference, check that the corresponding option button is set to Use and not to Create, otherwise you will see an error message telling you that the element already exists. If default storage areas have been defined for p-point sets and geometry sets, the Ppoint Set and Geom Set lists will show the contents of those areas. To use an existing p-point and/or geometry set, set the corresponding option button to Use and select from the list. To create a new (empty) p-point set or geometry set, set the option button to Create and type a new name in the text-box. To define descriptive texts for component parameters, type each description into the Parameter Descriptions text-box and then use the adjacent option button to insert the
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description into the parameter list in the required position. The parameters are numbered automatically as you edit the list. When you Apply the form settings, you will create the specified Category element plus two Text elements named, for example, catename-PTSE and catename-GMSE plus a set of Text elements (one for each parameter) named catename-PA1, catename-PA2 etc. These Text elements will be used to identify, via their STEX attribute settings, the required p-point set, geometry set, and parameter descriptions for all components owned by the category. Note: catename is the name you allocated to the Category. The precise naming convention is determined by the current Naming Format setting. Note: This facility is only applicable to a category that has member elements that can be modified, namely Text pointers to the referenced data. It is not applicable to an empty category. To open a Graphical View form and display a 3D view of a component, navigate to the required component in the Members form (see Members Form) and select Display>Component from the main menu bar. The title bar of the form shows the type of catalogue element currently displayed (Piping Component, Section Profile, Structural Fitting, etc.). The form has two main parts:



4.55.1



•



Control Section, on the left-hand side, displays data settings relevant to the current element. It lets you navigate around the database hierarchy from within the form, and reset the display to show a different component.



•



Display Section, on the right-hand side, shows a 3D view of the current component and includes facilities for manipulating this view.



Model View Form Control Section The Control menu lets you update the form to show changes made elsewhere. •



To display a different component, navigate to the required element in the Members form (see Members Form) and select Control>CE. The displayed data and the graphical view will both be updated.



•



To update the graphical view to use any newly defined representation rules, select Control>Re-load Repr (then use the Repr. button described for the form's Display Section).



The References list provides a quick way of navigating to elements which are referenced by the current element. It shows the referenced point set, geometry set, detail and material texts, bolting data, etc. When you select a reference element in the list, you will navigate to it automatically in the Members form (see Members Form). The Category entry shows the owning Category element, so that you can easily see the position of the current element in the catalogue database hierarchy. The Parameter Definitions list shows all parameters for the current element and their current settings. These are shown for information only; to change any of the settings, use the Model Settings form (see Model Settings Form). Note: These settings are read directly from the catalogue and default to a list of basic parameter numbers if any of the required data is not accessible.)
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4.55.2



Model View Form Display Section This part of the form contains the 3D graphical view area and a number of menus and gadgets for controlling how the view appears. The 3D view is controlled in a very similar way to that in the DESIGN module. If you are not familiar with this, see Manipulating the Model View. The small toggle buttons immediately above the view area let you superimpose some graphical aids on the component display. These are: Plines



shows position and direction of plines for a structural component



PKEYs



shows identification keys (NA, TOS etc.) for structural plines



Ppoints



shows position and direction of p-points



Axes



shows directions of X, Y, Z axes used for the component's coordinate system



Insu.



shows insulation if this has been defined for the current component type



To change the size of the displayed graphical aids, use the Graphics Defaults form and then toggle the aid off and on again to update the display. Note: Some aids may not be appropriate to the type of component being displayed, in which case an On setting will be ignored.) The Repr. option button lets you specify the level of detail shown for the displayed component. Either select a specific representation by name, or use the Choose option to select automatically a suitable representation for viewing the current element's full geometry. Each named drawing representation is defined in terms of its drawing levels, obstruction level, centreline and tube settings, etc., via a predefined set of representation rules.



4.55.3



Manipulating the Model View Note: Menu options in this topic refer to the right-hand mouse button menu, not the main application menus. To change the view direction, use one of the following methods: •



Drag the sliders in the borders of the view area. (If the borders are not visible, select Settings>Border to show them.)



•



Set the view direction explicitly by selecting one of the options under the Look or ISO sub-menus.



•



Use the mouse buttons in Rotate mode.



To change the scale of the view, use one of the following methods: •



Select Limits>Component to scale the display automatically so that the component fits into the view area. (Note that this is only applicable if the current component is a 3D element for which a limits box can be calculated; it does not work for a 2D structural profile.)



•



Select Limits>Increase or Decrease to rescale the display by changing the current limits box.



•



Use the mouse buttons in Zoom mode.



To change the background colour for the view area, select Settings>Background Colour and choose a colour from the resulting Colour Selection form.
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To toggle between colour shaded and wireline representations of the component, select Settings>Shade.



4.56



Modify Attributes Form The form shows if you have write access to the current element, and if you are prevented from modifying the element.



There is an option for this form to track the current element or not. Different lower panels appear according to the type of attribute. Attributes such as Name, Purpose and PAXI that require a single input line appear as in this example. The examples below show the panels for: •



Purpose



•



reference attributes (with search and CE buttons – note that the CE button is deactivated if the form is tracking)
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•



bltref



•



text strings (may be multi-line)



•



numbers



•



booleans (toggles).



•



name
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If you want to view or change the attributes of a different element, navigate to it in the Members List and click the CE button on the Modify Attributes form. To change an attribute setting, select the attribute in the list. If the attribute can have only one of two values (such as True or False for a logical attribute), this action will toggle to the other setting; otherwise a form will be displayed showing a text area into which you can type the new setting.



4.57



Modify Component Model Form Lets you modify the individual p-points and/or geometric primitives used to define the currently displayed component. The two lists show all existing p-points and geometric primitives for the component. Select the item you want to modify in the appropriate list or, if a list is empty, click the button above it (labelled Ppoints or Geometry) to select it. The lower part of the form will show those options relevant to the specified type of item.



4.57.1



To Modify an Existing P-point or Geometric Primitive Set the left-hand option button to Modify. The selected p-point or primitive type will be shown on the right-hand option button (changing the latter has no effect for the Modify option). When you click Apply, you will see a P-point Definition form or a Primitive Definition form applicable to the specific type of element selected. Edit the settings as required.



4.57.2



To Create a New P-point or Geometric Primitive Set the left-hand option button to Create and use the right-hand option button to specify the type of ppoint or primitive that you want to create. When you click Apply, you will see a Ppoint Definition form or a Primitive Definition form applicable to the specific type of element selected. Edit the settings as required.



4.57.3



To Delete an Existing P-point or Geometric Primitive Set the left-hand option button to Delete. The selected p-point or primitive type will be shown on the right-hand option button. When you click Apply, the selected item will be deleted. Important: If you modify a p-point set or a geometry set in any of these ways, remember that your changes will be applied to all components which reference that p-point set or geometry set, not just the component from which you carried out the modification.



4.58



Modify Equipment Specification Form This form lets you modify a standard equipment item by selecting a different design template on which it is to be based. You use this form in a similar way to the Create Standard Equipment Form which was used to create the equipment refer to Equipment User Guide. The only difference is that the modification form has a CE option to associate it with an existing equipment item, in place of the naming options on the creation form.
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When you have fully specified the equipment, click Apply to implement the changes. The position of the equipment’s origin, and of any extra nozzles etc. which you may have added as members of the equipment element, will remain unchanged.



4.59



Modify Part Family Form This form lets you change a Part Family.



Amend the relevant details and select the Apply Changes button to save the changes.
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4.60



Modify Pconns Form This function allows you to change the connection types on the Ppoints of elements with a given SKEY for one or more specifications.



Select the specifications you wish to change, in the SPEC Elements scrolling list. Enter the SKEY you wish to modify into the SKEY text box and define the changes in the Modify Pconns From - To text boxes. To select the Pconns to modify, enter the Ctype for each Pconn in numerical order, separated by spaces, into the From text box. To change all the Pconns for an SKEY enter a ‘*’ into the From box. The new Ctypes must be entered for each Pconn in numerical order, separated by spaces, into the To text box. Note: Text box entries are case sensitive. Click the Apply button. The changes are carried out and the details are shown in the Output list box. If the Report changes to file box is checked, a report of the changes is saved to the file specified in the File text box.
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This file will act as a macro to reverse the changes if you require so to do. It can be run by typing ‘$M ’ in the Command Window (see Command Window).



4.61



Modify Report Template Form This is the standard windows file open form that lets you select the report to change.



4.62



Modify Standard Equipment Form This form is accessed from the Modify>Equipment Specification menu. It lets you modify a standard equipment item by selecting a different design template on which it is to be based. You use this form in a similar way to the Create Standard Equipment Form that was used to create the equipment refer to Equipment User Guide. The only difference is that the modification form has a CE option to associate it with an existing equipment item, in place of the naming options on the creation form. When you have fully specified the equipment, click Apply to implement the changes. The position of the equipment’s origin, and of any extra nozzles etc. which you may have added as members of the equipment element, will remain unchanged.



4.63



Multiwrite Claimlist Form This form is used to control user claims. If you are working in an extract database, you will also need to consider extract claims, which are controlled using the Extract Data Control form.



Multiwrite databases have a claim mode, which is set when the database is created: •



If the claim mode is Explicit, you must claim an element before you can work on it
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•



4.63.1



If the claim mode is Implicit, an element which you start changing will be automatically claimed, but you can also choose to claim it explicitly before you work on it, using this form.



Claim List Option Button The Claim List option button can be set to: •



Active Claimlist. This is your Claimlist. A list of all the significant elements that you have claimed will be displayed in the Elements list.



•



Others Claimlist. The Elements scrolling list will show all claimed elements of all users in the current MDB except those in the Active Claimlist. You name is also shown in the Elements list next to the element name or Refno. An additional option is added to this gadget for every individual user who has a Claimlist. For example: USERA Claimlist



Note: Clicking on any element in the Elements list will navigate to that element. Elements are claimed and unclaimed using the options on the menu at the top of the form. Control Update



updates the list. The list will be automatically updated each time it is shown, and the



Active Claimlist



will be updated when you claim elements using the form, but in other cases the list may not show all the claimed elements unless you use this option.



Close



closes the form.



Claim and Unclaim Unclaim



is only active when there are elements in the Active Claimlist.



CE



claims or unclaims the CE and all of the hierarchy below it.



CE Members



claims or unclaims the members of CE and all of their hierarchy below, but not CE.



CE only



claims or unclaims CE only, not any hierarchy below it. This can be used, for example if you want to change an attribute such as a description which will not affect any elements below the current element.



CE Members only



claims or unclaims each member only and not the hierarchy below.



Pick..



Only active in DESIGN. Allows you to claim or unclaim elements by graphical picking using event driven graphics.



List



claims or unclaims all elements in the selected lists. Lists are created using the Lists/Collections form.



In addition, the Unclaim option has the following: All



unclaims all elements in the from the Active Claimlist and updates all the Claimlists.



Selected



unclaims all items selected in the Elements list.
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Colour



is only active in DESIGN. The options are: Highlight



displays a colour selection form. When a colour is picked then all the elements in the



Elements



list will be highlighted in that colour, in all graphical views. Only elements already in Drawlist will be highlighted; elements are automatically added to the Drawlist. You can different colours for each user Claimlist.



Unhighlight



unhighlights the CE, all Elements in the selected Claimlist or All elements in the graphical views.



Databases



allows you see all the claimed elements in the MDB, or in the DB selected from the submenu.



the the not use



Unclaiming You must unclaim any elements which you have claimed before other users can access them. Other users must do a Getwork before they can see your changes. You cannot unclaim an element that you have changed until you have done a Savework. Changing module or leaving will unclaim all elements.



4.64



Naming Format Form This form lets you specify a standard naming format, incorporating the current Category name, which is to be used for parameter descriptions etc.



Click the radio button against the preferred format. The current naming format is shown immediately below the left-hand end of the main menu bar.



4.65



Naming Rules Form This form lets you define individual naming rules.
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Data Input



full details of the naming rule



Data Display



4.66



Key



list of current naming rules



Data



details of the highlighted naming rule



Naming Settings Form Autonaming has been added to PARAGON under the menu Settings > Naming. It works in the same way as autonaming in DESIGN.



Naming rules are stored in the file: %pdmsdflts%\cat-nam.pmldat Element type rules are stored in the file: %pdmsdflts%\cat-element-rules.pmldat
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A basic example set of rules are included in the application.



4.67



New Report Template Form This form lets you generate a new template to be used for equipment reports.



4.67.1



Page Information Options The options under Page Information on the menu at the top of the New/Modify Report Template form allow you to add information which is not specified in the body of the report. The options are: •



Set a Header



•



Set a Footer



•



Insert an Introduction into the Report



•



Insert a Summary into the Report



•



Set the Page Length



Each option displays a form with a text pane. You type the information you want in the text pane. Each line of information is entered as an expression. For full information about expressions, see Introduction to Expressions, in the Software Customisation Reference Manual, but a summary of the information you are most likely to need is given below.
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Text must be entered in quotes. For example: 'Page number' You can include variables in the expressions. Any PML variables can be used. Variables must be preceded by one of the functions vtext, vval or vlog, which ensure late evaluation of the variables. For example, to show the page number on every page of the report, enter the following expression in the header or footer: vtext !pageno If you want to combine text and variables in the same expression (that is, on the same line, you must combine them using the text operator +. For example, if you want to number the pages with the format Page 1, Page 2 an so on, you should enter the following expression in the header or footer: 'Page ' + vtext !pageno



4.67.2



Selection Options The Selection options on the New Report Template form are used as follows. These options may also be available to the user running a report. Type(s) allows you to specify the type of item you want to report on, and the level in the database hierarchy below which the selection will be made. Any element type can be entered. If you want to report on several types, enter the types in the text box, separated by spaces. For example: VALV FLAN selects all valves and flanges BRANCH ITEMS selects all branch items BRANCH MEMBERS selects all branch members With allows you to restrict the report to elements of the given type whose properties satisfy given conditions. For example, you can report on Elbows with ABORE greater than 50. Hierarchy allows you to specify that only the parts of the database under given owning elements will be included. You can specify the element in two ways: Type in the name of the elements. Note that except for WORLD, the slash before the element name must be entered, because you can specify a list of elements, and also use OF to specify members of elements. For example: WORLD to report on all items in the current world /BRANCH1 OF PIPE211 to report on all items in BRANCH1 of PIPE211 /PIPE211 /PIPE212 /PIPE213 to report on all items in the given pipes. CE to report on the current element. Select the Hierarchy button. The Hierarchy form will be displayed. Note: If you do not specify an element for the top of the hierarchy, the report will include all the databases in your current Multi-database, unless you have use the Volume or From options on the Hierarchy form.
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4.67.3



System Command Option The System Command text box on the New/Modify Report Template form allows you to give a system command that will be run when the report has been completed. For example, you could use this option to send the report output to a printer, or to run a macro to process the report. The command is entered as an expression. For full information about expressions, see Introduction to Expressions, in the Software Customisation Reference Manual, but an example of how to enter a system command is given below. To send the report output to a printer, enter: 'print' + vtext !filename where: print is an MS DOS command, which must be enclosed in quotes. vtext is a function used for the late evaluation of variables. !filename is a variable, which outputs the file named in the Filename field to the printer when the report is run.



4.67.4



With Option The With option on the New/Modify Report Template form allows you to restrict the report to elements of the given type whose properties satisfy given conditions. Enter an Expression in the text box. For full information about expressions, see Introduction to Expressions, in the Software Customisation Reference Manual, but a summary of the information you are most likely to need is given below. The expression you enter here is going to be a combination of attributes or pseudoattributes, logical operators and values. For example, if you are reporting on Elbows (that is, you have entered ELBO) in the Type text box), you can restrict the report to Elbows with ABORE greater than 50 by entering: ABORE GT 50 where ABORE is the attribute, GT is an operator meaning greater than, and 50 is the value. The operators you can use are: •



EQ equal to



•



NE not equal to



•



GT greater than



•



GE greater than or equal to



•



LE less than



•



LT less than or equal to



You can specify more than one condition using the operators AND, OR and NOT. For example, to report on Elbows with ABORE greater than 50 but less than 100 by entering: (ABORE GT 50) AND (ABORE LT 100)
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4.68



Nozzle Specification Form This application lets you build up a specification by reference to the attribute settings of existing nozzles in the catalogue database. The specification simply acts as an index to allow any required nozzle to be located easily.



Before you begin, you should have created at least one Specification World with its PURP attribute set to indicate its suitability for storing nozzle specifications. To build such a specification, navigate to a catalogue element (CATA, SECT or CATE) that contains all nozzles that are to be accessed via the new specification. The upper part of the form lets you specify details of the overall SPEC element to be created; the lower part lists all nozzles below the current level in the catalogue and lets you specify which ones are to be included in the specification. If required, change the default settings for Spec, Description and Standard. The Spec World option button lists all available SPWL elements for the appropriate generic type (as controlled by the setting of the PURP attribute). If more than one is available, select the one below that the new SPEC element is to be created. The left-hand scrollable list shows the category (CATE) elements, while the right-hand list shows the nozzles in the selected category. By default, all listed nozzles will be incorporated into the specification. To prevent one or more nozzles or complete categories being included in the specification, select them in the relevant list and click the Remove button below that list. The 'removed' entries will only be shown (marked with a * symbol) if the Hidden button above the list is set to On. To reverse the process, select a 'removed' entry and click the Reinstate button. When the lists show only those nozzles which are to be selectable via the new specification, click OK to build the specification.
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4.69



Output Options Form The options in the Output frame allow you to specify the elements to be included in the Output. You can select: All Elements, or Specific Types. If you select Specific Types, you can press the Define button which will display the Specific Types form.



Standard Attributes



All the standard attributes of the elements to be output will be included in the Output file.



User Defined Attributes



All the user-defined attributes of elements to be output will be included in the output file. You can only switch this option on when Standard Attributes has been switched on.



References/Connections



Any database element cross-references for the Output elements will be added to be Output file. This option will create a reference table at the bottom of the Output file to set all the cross-references between database elements.



Re-input Create New Elements



If this is switched on then the output will be in the form: NEW %element%



Modify Existing Elements If this is switched on then the output will be in the form: NEW %element%OLD %element%
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Format Use Same Reference Numbers



If this is switched on then the output will be in the form: NEW %element% REF =1234/5678 The reference must not exist in the project when the Output file is re-input as a macro, and so this option is only used to input data to a different project or when elements have been deleted from the current project.



Comment Reference Number



The original element reference numbers will be shown as comments. For example: NEW BOX /BOX1 $(=1234/5678$)



Line Numbers



Each command line in the Output file will have an index number. A name and reference index table is included as a comment at the bottom of the file.



Tab Spacing



This allows tabbing or indenting from 0 to 6 character spaces. Each new level of hierarchy is indented and the attributes of each element are indented. For example: new stru new box xlen 100 . … etc. … end end



File Menu Save



This option will save the settings shown on the form to a file in the $PDMSUSER directory called desoutput. pmldat for DESIGN module where the des prefix is changed for DRAFT, PARAGON and SPOOLER. This is consistent with the conventions used for other user default settings.



Load



This option will load the settings as stored in the user defaults file onto the form. If no settings have ever been saved then the AVEVA defaults will be loaded.



Default



These are AVEVA defaults to provide the user with benchmark settings.



When the form is first shown the user defaults will be displayed if there is a saved file, or else the AVEVA defaults will be displayed. Any subsequent showing of the form will display the current settings.



4.70



Page Length Form The Page Length form will be displayed when you select Page Info>Page length from the menu on the New Report Template Form. Enter a page length in lines. The number of lines must be between 5 and 500.
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4.71



Parameter Setting Form Lets you specify values for all parameters relevant to the current type of component. If you are using a standardised Pipework category or standardised structural category, the parameter descriptions will be derived from the Text elements associated with that category (and only the appropriate number of parameters will be shown). If you are not using a standardised category, the initial settings will be taken from the last member (if any) of the current category. If there are no members, a default form will be shown which lets you enter up to 30 parameter settings. In the latter case, the parameters will have numbers only, with no descriptions. Edit the data settings in the various text-boxes as required so as to define the parameter values for the component. This form has no command buttons; its settings represent part of the catalogue item definition form with which it is displayed, and are stored when the Apply button on the latter form is clicked.



4.72



Part Family Form Part Families are managed via the new Part Family form, available from the menu entry Modify>Part Family. Multiple versions of this form can be shown concurrently, allowing different Part Families to be viewed simultaneously. A Part Family is a PRTELE containing GPARTs (or an empty PRTELE).
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The Part Family list allows you to select some or all of the parts in the family for modification. Information displayed and updated in the lower panels then applies to all the parts selected. A different Part Family can be displayed using the CE button and a Part Family viewed earlier in the current session can be selected from the list alongside the CE button.



New parts can be created using the Create button and selection. Parts are created relative to the current selection in the list. Selected parts can be deleted using the Delete button. The Attributes, Properties and References buttons control which data is displayed in the lower panels.



4.72.1



Attributes The Attributes view displays the key part attributes. If other attributes are to be modified, this can be achieved using the Modify Attributes form invoked via the Edit All Attributes button. When multiple parts are selected, any data item that is not the same for all selected parts is indicated by the text as shown in the Attributes view alongside. Any updates will be applied to all selected parts. Updates will not be applied for fields containing the text .



4.72.2



Properties The Properties view displays user defined properties defined on each part. Properties are stored as Text elements below each part, and each text has Rtext, Stext and Ttext attributes. This allows 3 different values for each property to be entered per part, e.g. to support multi-language catalogues (analogous to Detail Texts for ISODRAFT). All available properties for the selected parts are listed. A star character in the first column indicates if the property is present on all selected parts. When an update is applied, you has the option of automatically adding the property to selected parts that don’t already have it, otherwise it is updated only on those parts that do already have it. If a new Purpose is entered, it can be applied as a change to the selected property, or it can be added to the selected parts as a new property. The selected property can also be deleted from the selected parts.



4.72.3



References The References panel displays the reference attributes for the selected parts – catalogue ref, template ref, draft symbol set ref, detail text, material text, bolt ref and component ref. Selecting a reference in the list displays the current setting. This can be changed by entering the name of a new reference element, or by navigating to the new reference element and pressing the CE button on this panel, or by pressing the Search button to search for an appropriate reference element. Each reference attribute has its own display in the right hand side of the panel. These are shown below for a flange (except for the template which is shown for a pump). Data shown
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inactive is read only on this form. The reference element itself may be modified by pressing the Edit button on the panel.



4.72.4



3D Model First is the 3D Model (Catref). Editing the 3D Model brings up the new Category Form.



4.72.5



3D Template Second is the 3D Template (Tmpref) – note that this cannot be edited in PARAGON.



4.72.6



2D Symbols Third is the 2D Symbols - Marine Diagram Symbol Group and Name, and Draft Symbol Set (Drssref). The marine diagram Symbol Group and Symbol Name can be edited directly in the Marine Diagram Symbols frame. Editing the Draft Symbol Set brings up the new Draft Symbol Sets Form.
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4.72.7



Iso Description Fourth is the Iso Description (Detref). Editing the Iso Description brings up the existing Detail Text Definition Form.



4.72.8



Iso Material Fifth is the Iso Material (Matxt). Editing the Iso Material brings up the existing Material Text Definition Form.



4.72.9



Bolts Sixth is the Bolts (Bltref). Editing the Bolts brings up the Bolt Set form.
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4.72.10 Weight Seventh is the Weight (Unit Weight or Component Weight - Cmpref). Editing the Weight brings up the new Properties Form.



The Search button on each Reference panel brings up the Search panel, containing the new Search control (refer to Search Form). This panel will be prepopulated with the appropriate search criteria for attribute concerned. You can then make any desired changes and then press the Find button. If a result row is selected, the Use button will be activated. Pressing the Use button returns to the previous Reference panel with the chosen value in the text field ready for Apply Changes. Pressing the Back button returns to the previous Reference panel with no change.



4.73



PCONN/SKEY Compatibility Reports Form This facility generates a report (in .csv format) detailing the SKEYs and Pconns for all the elements in the selected specifications. The reports are saved into the selected directory, default %PDMSUSER%.
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Select the specifications you wish to report on, from the scrolling list and click Apply. The reports are generated and saved in the selected directory, shown at the top of the form. The reports can then be viewed in a spreadsheet or text processor.



4.74



Profile Category Definition Form This form lets you create or modify a structural category for storing profiles and their related elements using default settings. The form lets you define a Pline set and a 2D profile set which will be referenced automatically by all profiles owned by the category. It also lets you define descriptive texts for profile parameters, making it easier to identify the attribute to which each parameter number corresponds when you create the profiles themselves. If default storage areas have been defined for Pline sets and profile sets, the Pline Set and Profile Set lists will show the contents of those areas. To use an existing Pline and/or profile set, set the corresponding option button to Use and select from the list. To create a new (empty) Pline set or profile set, set the option button to Create and type a new name in the text-box. To define descriptive texts for profile parameters, type each description into the Parameter Descriptions text-box and then use the adjacent option button to insert the description into the parameter list in the required position. The parameters are numbered automatically as you edit the list. When you Apply the form settings, you will create the specified STCA element plus two Text elements named, for example, catename-PTSS and catename-GMSS plus a set of Text elements (one for each parameter) named catename-PA1, catename-PA2 etc. These Text



© 2007 AVEVA Solutions Ltd



4:75



12.0



Catalogues and Specifications User Guide Forms



elements will be used to identify, via their STEX attribute settings, the required Pline set, profile set, and parameter descriptions for all profiles owned by the category. Note: catename is the name you allocated to the Structural Category. The precise naming convention is determined by the current Naming Format setting.



4.75



Profile Specification Form The upper part of the form lets you specify details of the overall SPEC element to be created; the lower part lists all profiles below the current level in the catalogue and lets you specify which ones are to be included in the specification. Set the Sort by option buttons to show how you want the specification 'questions' (SELE) to be structured. You will usually set the Generic Type option to Yes and the Owner Type option to either Section or Category, depending on how your structural catalogue is configured. If required, change the default settings for Spec, Description and Standard. The Spec World option button lists all available SPWL elements for the appropriate generic type (as controlled by the setting of the PURP attribute; see Create Specification World Form). If more than one is available, select the one below which the new SPEC element is to be created. The left-hand scrollable list shows the category (STCA) elements, while the right-hand list shows the profiles in the selected category. By default, all listed profiles will be incorporated into the specification. To prevent one or more profiles or complete categories being included in the specification, select them in the relevant list and click the Remove button below that list. The 'removed' entries will only be shown (marked with a * symbol) if the Hidden button above the list is set to On. To reverse the process, select a 'removed' entry and click the Reinstate button. When the lists show only those profiles which are to be selectable via the new specification, click OK to build the specification.



4.76



Properties Form Properties data can be created and modified using the new Properties form, available from the Create and Modify menus. This form can be used to edit component data such as weights, and material data such as densities. It can also be used to create new elements using the New option gadget.
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Clicking on an attribute swaps the form panel to edit that attribute. Clicking on the Attributes button swaps back.



4.77



Query Data Access Control Form This form lets you view the access rights of users.
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At the top of the form, a message will be displayed indicating whether or not Data Access Control is switched on. The form is divided into two tabs: The User Rights tab displays the Data Access Controls that apply to the current user. The tab displays the ACRs that apply to the current user, and the Roles and Scopes that define each ACR. The Element Access tab is used to view which attributes of an element a user has access to, and the DAC restrictions on operations that the user can carry out on the element. Where restrictions apply, the appropriate error message is listed alongside the attribute or operation. On entry, the name of the current element is automatically displayed in the text field at the top of the form. Attribute names are displayed in the top list, along with the level of access the user has to each of the selected element's attributes. Operations are displayed in the bottom list, along with the restrictions that are applied to the user when carrying out these operations on the selected element. To view the data access restrictions for another element, either type the name of this element in the text field, or make the element the current element. When the required element is entered or selected, press the CE button.
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This form is for information only: Data Access Control can only be switched on and off in ADMIN, and Access Rights can only be changed in ADMIN.



4.78



Query Project Form This form lets you perform queries on a range of project data. The form consists of five tabs.



The attributes displayed on this form can only be changed by the System Administrator.



4.79



Quick Reports Form This form lets you create reports with basic formatting. You cannot save the report template. The options on the form are as follows: File textbox and Term button



You can enter a filename for the output report. If you just want to see the report on the screen, leave the File text box blank, or press the Term button, in which case any filename given will be ignored.



Types



Element types can be specified. Examples: bran mem VALVE gask flan If this text box is left blank ALL TYPES will be reported on.
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With



This option is a way of narrowing down the report. Enter an expression, for example: abore gt 30 tpos[3] le 1000 abore gt 30 AND name of owner neq ‘/B-1-2’



Columns



These are the attributes to be output in the report. The attributes you specify will be used as headings to the columns. For example: name owner hpos tpos You can enter expressions, enclosed in round brackets. The following example outputs the type, name, and the first three characters of the owner's name: type name (substr(name of owner, 1, 3))



Hierarchy



Enter the element or elements at the top of the hierarchy that you want to report on. Because you can give a list of elements, you must enter the slash character before each name, except for WORLD. For example: World /* /200-B-4 /250-B-5



Run the Report



Click this button and the report will be generated.



Note that when you press the Dismiss button, the contents of the form are kept. Everything you entered will be shown on the form when it is displayed again.



4.80



Reorder Form This form lets you rearrange the members list order for any owning element.



To move individual elements to specified positions in the members list of their owner, navigate to the owning element in the list and select Modify>Hierarchy>Reorder.
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The form shows two lists of members of the current element. To move an element to a different list position: 1. In the left-hand list, select the element to be moved. 2. In the right-hand list, select an element adjacent to the required list position. Set the Before/After option button to specify the exact position relative to the selected member. 3. Click Apply to move the element to its new list position. 4. Repeat Steps 1-3 if you want to move other elements before you Dismiss the form.



4.81



Report Details Form The Report Details form will be displayed when you run a report by selecting Utilities > Reports >Run, and select a template which gives you some control over the content of the report. According to how the template is set up, you may be able to specify: Filename



If you can specify a filename, the report will be sent to the given file in the directory REPORTS. If you leave the text box empty, the report will be sent to the screen. If there is no filename text box, the filewill be sent to the file named in the template, or to the screen, if the template specifies a screen report.



Type(s)



Allows you to specify the types of item you want to report on. For example, VALVes, ELBOws



with



Allows you to restrict the report to elements of the given type whose properties satisfy given conditions. For example, you can report on Elbows with ABORE greater than 100. For more information.



4.82



Hierarchy



Allows you to specify the level in the database hierarchy below which the selection will be made



Volume



You can specify a Volume in the model, and report on elements Completely within or Partially within it. Selecting Completely within or Partially within option will display the Report Volume form.



From



These options are used together with the Volume option. You can specify:



MDB



which will select all elements in the master database within the volume.



Drawlist



which will select all elements in the Drawlist within the volume.



Obstruction list



which will select all elements in the obstruction list within the volume.



Report Format Form The Report Format form will be displayed when you select Options>Other Formats on the menu on the New/Modify Report Template form. It allows you to output a report in CSV (Comma Separated Variable) format, which can be read into a spreadsheet.
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You can specify the field separator and text delimiter. Values in the report are recognised as text if the Units option on the Creating Column form is set to Off.



4.83



Resize Form Lets you resize the Members list. Type the required dimensions into the Width (number of characters) and Height (number of lines) textboxes, pressing Enter after each entry. The dimensions are in screen character cell units (remember that a screen character cell is not square, but is higher than it is wide). The default size is 10 lines high by 30 characters wide.



4.84



Runtime Prompts Form The Runtime Prompts form will be displayed when you select Options>Runtime Prompts on the menu on the New/Modify Report Template form. It allows you to define which parameters of the report can be set by the user when running the report. Switch on the parameters in the list. The options correspond to the options on the New/Modify Report Template form. If you have set values on the Report Template form, they will appear on the Report Details form, which is displayed when the user selects a report template, but the user will be able to change them. Note: If you specify in the template that a report will be sent to a file, and the user removes the filename on the Report Template form, the report will be sent to the screen. However, if you specify that the report will be sent to the screen, do not switch on the Filename option on the Runtime Prompts form, because the report will be sent to the screen even if the user gives a filename. Note: Do not set any runtime prompts for report templates intended for batch mode.



4.85



Savework / Session Comment Form Each time you SAVEWORK, either directly or indirectly by carrying out an operation in which PDMS automatically saves work, for example, changing modules, you start a new session. The Session Comment form allows you to enter a comment that will be stored with the current session, and can be used to record changes made during the session.
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The - , Current Session and + buttons are used to scroll though the comments for other sessions.



4.86



Search Form The new general Search form can be invoked from a number of places. This example shows it invoked from the Draft Symbol Set form.



To return to the search control you right mouse click within the grid to display a context menu and choose the New Search menu option. The search control (DB Type, Element Types etc) is redisplayed with the last search parameters still completed. You may then amend these and perform a new search. The following parameters may be specified to the search definition object. •



Database Type (Catalogue, DESIGN, Property, DRAFT etc.)



•



Result Element Types



•



Search In element list



•



Filter statements – each statement comprises: Attribute (including referenced attributes) Operator (=, , =, Like) Value



•



Results columns (including referenced attributes, each with an associated heading)



Results columns are only relevant when the search definition object is linked to a user search control. You control is initialized with the search definition parameters specified by the PML. You can amend the search definition parameters through the search control and then execute the search using a Find button on the control. Results are displayed in a standard grid control which overlays the search parameter items. You can select one or more of the results elements, which are then returned in an array via a callback to the PML caller. You can also make further selections or return to the search definition parameters panel to make a new search, via a right-mouse menu.
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There is full contextual validation of the search parameters – e.g. the Search In elements must be valid ancestors for the specified result element types. The search control has separate dialogue windows for you to choose which attributes columns to show in the results and to select referenced attributes for filtering by or for displaying in the results.



The individual components of the search control (DB Type, Element Types etc) will be initially populated with any values specified in the associated search definition object.



4.86.1



DB Type Combobox The Database type within which to perform the search. Allow selection of the database types: Catalogue, DESIGN, DRAFT, Property etc. Provide a poplist with legal values.



4.86.2



Element Types Text Box Space-separated list of one or more result element types for the search – the element types to search for. Allow entry of any element types that are valid for the specified DB Type by typing them in or by selecting using the Select Element Types to search for window which is accessed by clicking the associated button. Whenever the list of element types is changed: Reset the attributes for the results grid to the legal attributes for the result element types, with attributes NAME and DESC (if appropriate for any of the results element types) marked as visible. Element Types (…) button Displays the “Search Result Presentation Settings” dialogue window to allow you to choose result element types from a valid list.



4.86.3



Search In Text Box Space-separated list of one or more elements to search in. The default is the world (*) for the specified database type – meaning search the whole of the specified DB Type within the current MDB.
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Allow entry of any number of element names by typing them in or by selecting from the Catalogue browser associated with PARAGON, by clicking Add CE. Validate the entered list of element names on leaving the text box – they must be valid names of existing elements in the specified DB Type which can be ancestors for at least one of the specified Element Types.



4.86.4



Add CE Button Add the current element – e.g. as selected using the catalogue browser in PARAGON – to the Search In element list. Before adding, validates that this element is in the specified DB Type and that it can be an ancestor for at least one of the specified Element Types. If the element is already in this list then do not add it again.



4.86.5



Reset Button Resets the Search In to World – meaning search the whole of the specified DB Type within the current MDB.



4.86.6



Filter Grid Data grid to allow attribute filters to restrict the search. Each row of the grid is a “statement” comprising attribute name, operator, value. Filter Attribute Combobox An attribute of the result Element Types that is to be filtered by. Allow selection of any attribute that is valid for the specified result Element Types. Also allow selection of the special case “*Add Ref Attr” which displays the Choose Referenced Attributes window to allow the name of a referenced attribute to be specified. Each filter statement row must include a valid attribute. Creating a Filter Statement Using a Referenced Attribute The poplist for the Filter Attribute includes a first entry of *Add Ref Attr… When you selects this the “Choose Referenced Attributes” dialogue window is displayed to allow selection of a referenced attribute.
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Invoking the Choose Referenced Attributes window to select a referenced attribute to filter by. Filter Operator Combobox Allow selection of the following operators: "=", "", "=", ">", " 
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